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Confession time. When I first started developing dynamic websites with Dreamweaver UltraDev 4, I
made a complete mess of things. I believed rather naively that Dreamweaver would “do it all” for
me, and that all I needed to do was point and click. The first couple of projects actually went well,
giving me a false sense of security. As soon as I attempted anything that didn’t fit into the same pat-
tern as the basic tutorials, things began to go horribly wrong. Even though I’ve always been happy
working with code, one look inside Code view sent shivers up my spine.

Part of the problem was that I didn’t have a clear grasp of database structure or of what server-side
technology really involved. The other part of the problem was that I was treating Dreamweaver as a
WYSIWYG (What You See Is What You Get) program. If I saw something wasn’t in the right place, I
just highlighted it in Design view and hit DELETE. What I didn’t realize was that this left behind messy
code that caused even the simplest of applications to break. The more I deleted, the worse it got.

I don’t want that to happen to you. That’s why I wrote this book.

Who this book is for
To be able to develop dynamic websites with a server-side language like PHP, you need to have a
good grasp of the principles of web design. You should be familiar with the basics of HTML
(Hypertext Markup Language) or XHTML (Extensible Hypertext Markup Language), and preferably
have some knowledge of CSS (Cascading Style Sheets). You don’t need to know how to hand-code
a web page, but this book involves switching frequently into Dreamweaver’s Code view and making
adjustments to the code. Unless you are familiar with the basic structure of a web page, you are
likely to find it difficult to follow all the steps.

I assume no prior knowledge of PHP or working with a database. There are detailed instructions on
how to set everything up, and I will teach you the basic principles of both PHP and SQL, the lan-
guage used to interact with databases. The purpose is not to turn you into a “programmer,” but to
give you sufficient understanding of what is happening—and why—to help you avoid the mistakes I
first made.
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I hope this book will also be of value to readers who already have some knowledge of PHP, the
MySQL database, or both. Even the chapters that deal with PHP basics are designed to help
you work more efficiently in the Dreamweaver 8 environment. And by the end of the book,
you will be working on relatively advanced topics. I have included a number of custom func-
tions that the more code-minded reader will probably enjoy deconstructing and adapting. If
coding isn’t your idea of fun, you can just use the functions and not worry about how they
work.

Do I need to have Dreamweaver 8?
This is a book written specifically for Dreamweaver 8, and you’re unlikely to get the best value
out of it if you’re using an earlier version of Dreamweaver. At a pinch, you could probably use
Dreamweaver MX 2004, because most of the server behaviors are identical, although bugs in
the MX 2004 versions of the User Authentication server behaviors will prevent some parts of
Chapter 10 working as described, and you will not be able to do any of Chapter 12, which cov-
ers the new—and fascinating—XSL Transformation server behavior. However, you’ll also miss
out on the important enhancements that have been made to CSS rendering and Code view.

If you don’t have Dreamweaver 8—or any version of Dreamweaver, for that matter—all is not 
lost. You can download a 30-day trial version from www.macromedia.com/cfusion/tdrc/
index.cfm?product=dreamweaver.

All the other software required is either available as part of the Windows or Mac OS X operat-
ing systems, or free for download from the Internet. Download locations are given when
needed, throughout the course of the book.

Windows- and Mac-friendly
Everything in this book has been tested on both Windows and Mac OS X 10.3 and 10.4. Most
of the screenshots have been taken on the Windows version, but I have included separate
screenshots or descriptions when referring to features that are either exclusive to Mac OS X or
that are substantially different from the Windows version. Fortunately, there are very few dif-
ferences between the Windows and Mac versions of Dreamweaver 8, so Mac users should
have no difficulties in following the instructions.

All keyboard shortcut references are given in the order WINDOWS/MAC. If you’re
a newcomer to Mac OS X and don’t have a U.S. keyboard, you might be con-
fused by keyboard shortcut references to the OPT key. On the U.K. Mac key-
board, at least, this is labeled ALT. Whichever Mac keyboard you’re using, you
can recognize it by the symbol shown alongside.
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What if I’m new to Dreamweaver?
This is a Foundation book, so detailed instructions are given for each step. However, I recommend
that you familiarize yourself first with the Dreamweaver workspace. Open Dreamweaver Help by
pressing F1, and take a look at Getting Started with Dreamweaver and Dreamweaver Basics.

The following screenshot shows the Dreamweaver workspace in Windows, using the Designer
layout. (The position of each element is identical in the Mac version.) The screenshot shows a
PHP document open in Split view, which enables you to view part of the underlying code while
seeing a reasonably accurate representation of the final design. As long as you familiarize your-
self with the parts of the workspace labeled here, and have a good understanding of web page
layout, you should have no difficulty following the instructions in this book. Of the panel groups
shown on the right, the two most important ones for building dynamic sites—Applications and
Files—are shown expanded.

What this book covers
The book’s title really says it all: It’s about using PHP with Dreamweaver 8. If you’re new to
expressions like PHP and server-side programming, Chapter 1 gives you both an overview of
what’s involved and a brief explanation of what the server behaviors in Dreamweaver 8 are for.
Chapter 2 looks at the new features of Dreamweaver 8, with particular emphasis on PHP.
Chapters 3 and 7 provide detailed installation instructions for PHP, MySQL, and the phpMyAdmin
graphical interface to MySQL.

Panel groups

Insert bar

Code view

Design view

Tag selector

Property
Inspector
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Chapter 4 sets up the East-West Seasons case study that runs throughout the book, covering the
basics of PHP (Chapters 5 and 6) and all the PHP-related server behaviors in Dreamweaver 8
(Chapters 8 through 12). The book also covers building your own server behaviors (in Chapters
10 and 11).

The book focuses exclusively on PHP, so no time is wasted on how something is done differ-
ently in ASP, JSP, or ColdFusion. If it’s ASP that you’re interested in, take a look at Foundation
ASP for Dreamweaver 8 by Omar Elbaga and Rob Turnbull (friends of ED, ISBN 1-59059-568-8),
which is equally focused. Take a look, but buy my book first.

Support for this book
All the necessary files for this book can be downloaded from www.friendsofed.com/
downloads.php If you run into a problem with any of the instructions, compare your code with
the download files using the new File Compare feature in Dreamweaver 8 (as described in
Chapter 2). If that doesn’t work, check the errata page for this book at www.friendsofed.com/
books/1590595696. I try not to make any mistakes, but they occasionally slip through. The
errata page is also where you’ll find information that came to light after this book went to print.

If you still don’t find the answer, post a question in the friends of ED forum at 
www.friendsofed.com/ forums, and I’ll try to help you as quickly as possible. Please be as pre-
cise as you can about the nature of the problem. It’s much easier to answer a question along
the lines of “I did this in step 7 on page so and so of Foundation PHP for Dreamweaver 8, and
this happened” than “Chapter 2 (of unnamed book) doesn’t work.”

Layout conventions
Important words or concepts are normally highlighted on the first appearance in bold type.

Code is presented in fixed-width font.

New or changed code is normally presented in bold fixed-width font.

Pseudocode and variable input are written in italic fixed-width font.

Menu commands are written in the form Menu ➤ Submenu ➤ Submenu.

Where I want to draw your attention to something, I’ve highlighted it like this:

Sometimes code won’t fit on a single line in a book. Where this happens, I use an arrow 
like this ➥

This is a very, very long section of code that should be written all on 
➥ the same line without a break.

Ahem, don’t say I didn’t warn you.
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Chapter 1

What this chapter covers:

Understanding what makes a site dynamic

Introducing PHP and MySQL—the dynamic duo

Understanding the interaction between a database and a website

Learning how Dreamweaver automates communication with a
database

SO, YOU WANT TO BUILD DYNAMIC SITES?



Dreamweaver, like the Internet itself, has come a long way in the past few years. It’s not only the pre-
mier design tool for creating static websites (ones in which all the information is hard-coded into
each page); since 2002 when it incorporated support for PHP, ASP, ASP.NET, ColdFusion, and JSP, it’s
also become the tool of choice for many developers of dynamic websites. As the title of this book
indicates, I’m going to concentrate on using PHP with Dreamweaver 8. So, if you’ve already made up
your mind that PHP is for you, welcome aboard. If you’re unsure, I hope to have whetted your appetite
sufficiently by the end of this chapter to entice you to stay along for the rest of the ride.

Over the next few pages, I’ll explain how dynamic websites work, what’s so special about PHP and the
MySQL database that integrates so closely with it, and how Dreamweaver 8 can make development of
a database-driven website both easy and enjoyable. In subsequent chapters, I’ll show you how to use
some of the brilliant new features in Dreamweaver 8 and how to set up your computer with the right
development environment for dynamic sites, and I’ll teach you the basics of working with PHP. Then,
it’s on to the core theme of the book—creating dynamic web pages that interact with a database. By
the time you finish, you should have a solid understanding not only of the tools provided by
Dreamweaver, but also of the basic technology involved. The aim is not to turn you into a hardened
code warrior, but to give you the knowledge and confidence to dive under the hood when necessary
to troubleshoot problems or customize things to your own liking.

First of all, what does the term “dynamic” really mean when applied to a website?

What makes a site dynamic?
Several years ago, DHTML (Dynamic HTML) was regarded as the next big thing on the Web. Yet you
may be surprised to discover that DHTML has never been an official standard. As far as the World
Wide Web Consortium (W3C) is concerned, DHTML simply describes “the combination of HTML, style
sheets and scripts that allows documents to be animated” (www.w3.org/DOM/faq.html#DHTML-DOM).

In other words, DHTML is what Dreamweaver has always been so good at: automating rollovers and
other onscreen effects through JavaScript-based behaviors. Combined with CSS (Cascading Style
Sheets), this has become standard on the Web, which may explain why DHTML is no longer the buzz-
word it once was. Most web developers now just refer to JavaScript and CSS directly by name.

Confusingly, even when a website uses DHTML effects, it’s often referred to as “static.” That’s because
the underlying code is always the same each time it’s downloaded from the web server; the dynamic
effects are controlled entirely on the user’s computer, normally in response to mouse movements or
clicking form elements. In formal terms, this is client-side technology (see Figure 1-1).

Figure 1-1. Dynamic effects created with JavaScript and CSS involve no direct interaction with the server.
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all action takes place locally on the client
(user’s) computer



Increasing response to the user with server-side technology
These days, “dynamic”—when applied to a website—usually refers to the ability to change the content
or look of a web page before it’s downloaded to the user’s computer. In other words, the changes are
implemented on the web server. This is known as server-side technology, and the languages used to
build such sites—like PHP, ASP.NET, ColdFusion, and so on—are called server-side languages. Perhaps
the best-known example is Amazon.com. Although most pages look very similar, the content has an
amazing variety, and it changes in response to user action. Do a search for your favorite author (well,
my favorite author), and you’ll be presented with something like Figure 1-2.

Figure 1-2. The Amazon.com website presents information tailored to the 
user’s requirements through the use of server-side technology.

If you have ever used the Show/Hide Layer behavior in Dreamweaver, you’ll know that it’s possible to
put some of your page content in a hidden layer, and reveal it only when the user hovers over an
image or clicks on a particular link. Just imagine, though, if Amazon tried to do that! With literally tens,
maybe hundreds of thousands of items in the Amazon catalog, it would be impossible to download all
that information to your computer and use client-side technology to display just the parts you’re
interested in. It makes much more sense to use server-side technology to select the appropriate con-
tent and send you no more than necessary. It’s fast, efficient, and very effective.

Amazon.com stores most of its content in a database, and it uses a server-side language to extract and
display the relevant information. The system is based on a scripting language known as Perl, but similar
functionality is available by choosing any of the popular server-side languages supported by
Dreamweaver: ASP (Active Server Pages), ASP.NET, ColdFusion, JSP (JavaServer Pages), and PHP. The 
initials PHP originally stood for Personal Home Page, but that was considered inappropriate when 
it developed into the sophisticated language it has become today, so it’s now one of those curious
recursive names—PHP Hypertext Processor.
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The word server will crop up frequently in this book, and it’s important to understand that it has two
separate, but closely related, meanings. Primarily, it refers to a computer that stores files, such as web
pages, and “serves” them to other computers on request. This is known as a file server. A computer
that makes a request to a file server is known as a client—hence the expression “client-side,” which
refers to anything that happens on a user’s computer without further intervention by the file server.

The second meaning of server refers to the various types of software that process the requests from
visitors to a website. So, in addition to the physical file server, a web server, such as Apache, is needed;
and, if a site uses a database, you also need a database server, such as MySQL. Apache and MySQL are
software programs that are commonly installed on the same physical computer. I’ll show you how they
all fit together in the “How dynamic sites work” section later in this chapter.

Dreamweaver uses the term “remote server” to refer to the file server where you upload your web
files for display on the Internet—typically a hosting company. The term “testing server” identifies
where you test your PHP files before deploying them live on the Internet. Full instructions for setting
up a testing server are in Chapter 3.

Why choose PHP/MySQL?
Arguments of an almost religious nature often break out when discussing which is the “best” server-
side technology. All the languages supported by Dreamweaver are good, but it’s a good idea to pick
one and get to know it well. Once you have become proficient at one server-side language, you’ll find
the transition to another a lot easier, because they share many elements in common.

Strictly speaking, it is possible to mix different server-side technologies in the same website, as long as
the server supports them. I ran a hybrid ASP-PHP site for several months because I had an existing site
that I wanted to convert from ASP to PHP. Instead of waiting until everything had been converted, I
did the changeover in two stages. But this is an unusual scenario. It worked because I kept the two
parts of the site completely separate from each other.

So, why choose PHP/MySQL in preference to the others? Well, I wouldn’t have slaved over a hot key-
board night and day to write this book if I didn’t think PHP and MySQL were pretty special. And I’m not
alone: PHP is the Web’s most widely available server-side language. As of September 2005, it was in use
on more than 22.1 million domains (www.php.net/usage.php). MySQL is also reputed to be the most
popular open source database, with more than 6 million active installations (www.mysql.com). Because
PHP is a server-side language, it needs to work in connection with a web server. More often than not,
you’ll find it in combination with Apache, the software that runs more than two out of every three web
servers in the world today (http://news.netcraft.com/archives/web_server_survey.html).

Apache, PHP, and MySQL run on just about every operating system, including Windows, Mac OS X, and
Linux. This flexibility is one of the great advantages of developing with PHP/MySQL. Let’s quickly
review the others:

Cost: They’re free. Don’t be fooled into thinking this means they’re just for hobbyists. PHP 5
has full object-oriented capability. It can also work with all leading database systems
(Dreamweaver’s automatically generated PHP code, however, supports PHP only in combina-
tion with MySQL). MySQL is used by many leading organizations, including NASA, the U.S.
Census Bureau, Yahoo!, and the New York Stock Exchange. The fact that more than two out of
every three web servers run on Apache speaks for itself.
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Open source: As open source technologies, all three benefit from a rapid upgrade policy
based on need rather than commercial pressures. If a bug or security risk is identified, the
input of many volunteers helps the core development teams solve problems rapidly. Future
versions are available for beta testing by anybody who wants to take part, and they aren’t
declared stable until they really are. The same thriving community offers assistance and advice
to newcomers and experienced programmers alike.

Cross-platform capability: You can develop on your personal computer and deploy exactly
the same code on the production server, even if it’s running on a different operating system.

Security: Although it’s impossible to predict future developments, Apache servers are less vul-
nerable to virus attacks. Access to sensitive content can be restricted through PHP session con-
trol (this is the subject of Chapter 10).

One thing missing from that list is “ease of learning.” That’s not because they’re difficult—far from it.
All are relatively easy to pick up, but they do require a bit of effort on your part. If you have experi-
ence with other programming languages, your progress is likely to be much faster than if you are a
complete beginner. This book is designed to ease your progress, whatever your level of expertise.

How dynamic sites work
Although I refer specifically to Apache, PHP, and MySQL, exactly the same principles lie behind all
server-side languages and database-driven websites. The web server and the databases may be differ-
ent, but the component parts all fit together in the same way.

With an ordinary web page, the information is fixed at the time of design. All text, links, and images
are hard-coded into the underlying XHTML (Extensible Hypertext Markup Language). Although
dynamic effects, such as rollovers, can be achieved with JavaScript or CSS, the basic content remains
unchanged until the designer alters it in an editor like Dreamweaver and uploads it again to the server.
As was shown in Figure 1-1, there’s no direct interaction with the server once the page has been
loaded; everything takes place on the client computer.

Using code that acts as a template
Dynamic web pages built with a server-side language like PHP work in a very different way. Instead of
all content being embedded in the underlying code, much of it is automatically generated by the
server-side language or drawn from a database. A simple way of thinking about it in Dreamweaver
terms is that a dynamic page is rather like a template. Those parts of the page that you want to remain
constant are created in standard XHTML, while dynamic elements are scripted in a server-side language.

Although Apache is the web server that I recommend for developing with PHP, you can
also use Microsoft IIS on some Windows systems. Instructions for setting up both will be
given in Chapter 3.
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That doesn’t mean you need to use Dreamweaver templates to work with a server-side language, and
I won’t be covering their use in this book. You can use templates with PHP if you want, but often a sin-
gle PHP document is all you need to create in order to display hundreds, even thousands, of different
pages on your website. (Think how many books must be in the Amazon catalog, yet every page has the
same basic structure.) You build the basic structure in XHTML, and you rely on PHP to generate the
actual content dynamically, usually—but not always—drawing the content from a database. 

To show you a simple example of how this works, consider a copyright notice at the bottom of a web
page. In a static website, the code would probably look something like this:

<div id="footer">&copy; 1999-2005 David Powers</div>

The problem is that you need to change the second date on January 1 every year. Of course, you could
use a client-side solution, such as JavaScript, but there are two problems with this approach:

Date functions in JavaScript rely on the user’s computer clock being set correctly.

If the user has disabled JavaScript, the function will fail, almost certainly making a mess of your
design, unless you build in preventive measures.

A server-side solution eliminates both problems: The server makes sure the date is right, and it inserts
the necessary code before sending it to the client. If your server clock isn’t set correctly, the date will
still be wrong, but you have much more control over the clock on your own server than those on the
computers of your visitors.

So, how does the server-side approach work? You create a web page as normal, but instead of giving
it an .html extension (the default for static web pages on both Windows and Mac in Dreamweaver 8),
you give the filename a special extension that instructs the web server to process any dynamic code
before sending the page to the browser. Inside the page itself, you insert the necessary code where
you want the dynamic data to be displayed. In the case of PHP, you would give the filename a .php
extension and rewrite the previous copyright code like this:

<div id="footer">&copy; 1999-<?php echo date('Y'); ?> David 
➥ Powers</div>

Figure 1-3 shows how the web server handles the code. Anything between opening and closing PHP
tags (<?php and ?>) is sent to the PHP engine, converted into XHTML output, and sent to the browser
with the rest of the content. If you open the source view in a browser, the PHP code is nowhere to be
seen. It always remains on the server (hence the name ww “server-side technologies”). In this particu-
lar example, what lies between the PHP tags is an instruction to get the current year and display it.

You won’t be able to run this code on your local computer until you have installed PHP
and a web server as described in Chapter 3.
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Figure 1-3. The server-side code remains exclusively on the server, and 
ordinary XHTML output is sent to the browser.

Consequently, as soon as the New Year is rung in—even at the stroke of midnight—the correct year
will be displayed without any need to update the underlying code. In fact, as I’ll show you in Chapter
5, you can instruct the server to add the same block of code to every page on a site. So, you can make
the changes to just one page that contains the common code, rather than needing to update every
single one. In this respect, it’s similar to the principle of CSS, where a single stylesheet can control an
entire website, no matter how many pages it contains.

This example involves no user interaction; it simply displays the year. But server-side technology really
comes into its own when responding to user input. In Chapter 6, I’ll show you how you can use PHP to
email the contents of an online feedback form to your own mailbox; and in the second half of the
book, you’ll work with a database to create a random quotation generator (Chapters 8 and 9), a blog
(Chapter 11), and an image gallery (Chapter 11), as well as looking at how to password-protect
selected parts of your site (Chapter 10) and display input from a live news feed (Chapter 12).

Pretty powerful stuff, this server-side technology—and Dreamweaver takes much of the hard work out
of it, particularly when it comes to working with a database.

Taking a peek behind the scenes
Without getting too technical, let’s take a quick look behind the scenes to see how a dynamic page is
served up when a request comes from a user. Figure 1-4 shows the sequence of events.

Figure 1-4. A diagrammatic representation of what happens when a client computer makes a request to PHP

PHP code embedded in XHTML

As seen in browser

Browser source view
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1. The client computer sends a request to the web server (normally Apache).

2. If the requested page contains no PHP script, the XHTML, CSS, images, and any other page
assets are sent to the client.

3. If the requested page contains any PHP, the web server passes the script to the PHP engine for
processing.

4. If the PHP script initiates a database query, a request is sent to the MySQL server.

5. The results of the database query are sent back to the PHP engine for processing and insertion
into the page.

6. The web server assembles the entire page as XHTML and sends it to the client, together with
any images or other assets.

Once the client receives the data from the server, the page is displayed in the browser, which is ready
to receive any input from the user.

There’s a lot going on here, and this process can be repeated many times as the user interacts with the
page. Sometimes all six stages are required, and, at other times, PHP may simply do all the processing
itself without having to query the database. Although it sounds complicated, PHP, MySQL, and Apache
can search through many thousands of records in a fraction of a second, so the user may be totally
unaware of anything going on in the background. The biggest delay is often caused by a slow Internet
connection or network bottlenecks.

Apache, PHP, and MySQL are frequently located on the same computer (although in large operations
they may be distributed across several). Apache and MySQL run unobtrusively in the background, con-
suming very few resources, and are ready to spring into action whenever a request comes in.

Building dynamic sites with Dreamweaver
Dreamweaver 8 has a lot of new features to improve your productivity when working with PHP. I’ll
cover these in detail in the next chapter, but while I’m talking about databases, I’d like to take a look
ahead to what lies in store for you in the second half of the book. Dreamweaver makes connecting to
a database a breeze. It creates the code that displays the results of a database query in seconds, and it
automatically sets up navigation systems to page through a long set of results. (You’ll learn how to do
both of these in Chapter 8.) 

PHP is the language you’ll be using to communicate with your MySQL database, and although I’ll also
be showing you how to write your own PHP, Dreamweaver takes care of much of the complex coding
on your behalf by offering an extensive suite of server behaviors. You use server behaviors in a very
similar way to the JavaScript-driven behaviors that you might have used in Dreamweaver for validating
a form or creating rollover effects.

Programs like Apache and MySQL that run in the background are normally referred to
as daemons on Unix, Linux, and Mac OS X. Windows calls them services.
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An overview of Dreamweaver server behaviors
You can access Dreamweaver’s server behaviors in three different ways:

By clicking the plus (+) button in the Server Behaviors panel, located in the Application panel
group

By selecting the Insert ➤ Application Objects menu option

By clicking the appropriate icon in the Application category of the Insert bar

You won’t be able to use either of the first two methods until you have defined a PHP site in
Dreamweaver (covered in Chapter 3), but the Insert bar is always visible, and it’s where you find a lot
of the most commonly used features in Dreamweaver. If you’re new to Dreamweaver, you can learn all
about the Insert bar by selecting Help ➤ Getting Started with Dreamweaver. When the help window
opens, select Dreamweaver Basics ➤ Getting to know the Dreamweaver 8 workspace ➤ The Insert
bar. Let’s take a quick look at the Application category, so you have an idea of what Dreamweaver can
do when working with a dynamic data.

The Insert bar is displayed by default at the top of the workspace. If you can’t see it, select Window ➤
Insert or press CTRL+F2/ +F2. Normally, the Insert bar displays only the last category you were work-
ing in, as shown here:

The other categories are accessed from the drop-down menu at the left end of
the Insert bar. I find it a nuisance to open the menu every time I want to select
another category, and prefer to have the categories shown as tabs that can be
seen at all times. To select this option, choose Show as Tabs at the bottom of
the drop-down menu (as shown alongside). With the Application tab selected,
the Insert bar will then look like this:

If you prefer to revert to the default display, right-click/CTRL-click the title bar of the Insert bar, and
select Show as Menu. Throughout the book, I’ll use the tabbed interface, so if you’re using the default
layout, just select the appropriate category from the drop-down menu. There’s no difference in func-
tionality, but the tabbed interface takes up an extra 20 pixels of vertical space on your monitor; so if
you have a small monitor, the menu interface will give you a precious bit of extra real estate.
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As you can see, the Application tab of the Insert bar has a lot of icons, some of which activate drop-
down menus. I don’t intend to go into minute detail about what each one does—it’s easier to under-
stand their functions by actually using them—but the following quick rundown will give you an insight
into what you can expect to have learned by the end of this book.

Recordset and Stored Procedure One of the most fundamental operations when working with a
database is retrieving records that match your search criteria. This may be a list of products in an
online catalog, a staff list, or even the latest entries in a blog. Dreamweaver gathers the results of your
search into a recordset (in other words, a set of records), ready for you to display in your web page.
Clicking the Recordset icon opens the dialog box where you define which records you want a record-
set to contain. Dreamweaver then creates all the necessary PHP code, as well as a query written in SQL
(Structured Query Language), the language used to interact with all major relational databases. Most
of the process is automatic, although you will need some knowledge of SQL to build more complex
queries. I’ll be covering the main SQL commands as you progress through the second half of the book.

Stored procedures are very similar to recordsets, except they use preset queries stored
inside your database. Stored procedures aren’t available in MySQL prior to version 5.0, so
Dreamweaver doesn’t yet support them for PHP/MySQL, although it is hoped that an update
will eventually add this feature. Until then, the Stored Procedure icon serves no purpose
when developing a PHP site.

Dynamic Data This icon activates a drop-down menu with six options that enable you to
populate a variety of web page elements, such as tables, drop-down menus, and text fields
with data from your database. Normally, the data will be taken from a recordset. Although
this option appears on the Insert bar, it’s normally much quicker to access the same lightning
bolt icon in the Property inspector or in a dialog box. You will become very familiar with this
icon in a variety of contexts by the time you reach the end of this book.

Repeated Region and Show Region When displaying a list of products in a static web
page, you normally need to create a table and insert every item individually. That’s not nec-
essary with PHP. You just create a single row, insert the appropriate dynamic data, and then
apply Dreamweaver’s Repeated Region server behavior, which loops through all the results
and creates the code automatically. You can also choose whether to display all results, or
limit the page to just a specific number. (Recordset Paging, described in the next section,
automates the creation of a navigation system to move back and forth through a long set of
results.) Repeated Regions don’t apply only to tables; you can also use them with <div>s,
paragraphs, or any other integral page element.

Sometimes, your recordset may not contain any relevant results. The Show Region server
behavior creates the “smart” code that decides whether to display certain parts of the page
when that happens. You’ll learn how to use the Repeated Region server behavior in Chapter 8
and Show Region in Chapter 11.

Recordset Paging, Go to Detail Page, and Display Record Count These
server behaviors enable you to help visitors find their way around your website.
The most useful of these is Recordset Paging, which automates the construction
of a navigation system that lets users move backwards and forwards through a
long set of database results by spreading them over several pages. Recordset
Paging is covered in Chapter 8.
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Master Detail Page Set, Insert Record, Update Record, and Delete
Record The Master Detail Page Set is probably my least favorite server
behavior. It’s a good idea, but it’s complicated to set up, and very inflexi-
ble. I’ll show you a better solution using other server behaviors in Chapter
11. The three other server behaviors—Insert Record, Update Record, and
Delete Record—are the bread and butter of working with a database. The
names are self-explanatory. They’re very efficient and easy to use. You’ll
learn how to use them in Chapters 8 and 9.

User Authentication This set of server behaviors makes light work of password-protecting
sections of your site, such as a members-only area or the administrative back-end of a data-
base. You’ll use this suite of server behaviors in Chapter 10.

XSL Transformation This is a major new feature in Dreamweaver 8 that makes working
with XML very easy. You can either convert entire existing XHTML pages to incorporate XML
data, or you can create what Dreamweaver 8 calls an XSLT Fragment for incorporation into
a PHP page. Suitable XML sources can be files that you create yourself or a remote source,
such as an RSS feed. I’ll show you how to incorporate a live news feed into your website
using an XSLT Fragment and PHP in Chapter 12. (And if you’re confused by all this alphabet
soup, everything will be explained at the same time.) Although the code created by
Dreamweaver 8 is compatible with both PHP 4 and PHP 5, you will need access to PHP 5 to
make full use of this feature, as XSLT support is not enabled by default in PHP 4.

Looking ahead
As you can see, Dreamweaver puts at your disposal an impressive arsenal of tools that automate a
large part of building a database-driven website with PHP and MySQL. It’s important to realize, though,
that automatic code generation is only part of the story. No computer program, however sophisti-
cated, can completely automate everything for you.

Although working with a database is what puts real power behind dynamic websites, PHP is used for
much more. One of its most practical uses is gathering information from an online form and emailing
it. Sadly, this isn’t one of the functions that Dreamweaver automates for you.

So, rather than diving straight into working with databases and server behaviors, I intend to show you
first how to understand the basics of PHP, and use that knowledge to build an online contact form. As
well as being of immediate practical use, this knowledge will ease the transition to working with data-
bases and customizing Dreamweaver’s automatically generated code.

Dreamweaver 8 has some excellent new features that make diving under the hood into the underlying
code an experience to be enjoyed—and not something to fear. We’ll take an in-depth look at them in
the next chapter. Then, in Chapter 3, I’ll show you how to set up the development environment for
working with PHP in Dreamweaver. The rest of the book will be centered on a case study called East-
West Seasons that will be used to demonstrate the transition from a static website to a dynamic one—
setting that up is the subject of Chapter 4. Chapters 5 and 6 will be devoted to the basics of PHP and
getting that contact form online. Then, from Chapter 7 onward, you’ll be working with databases.
There’s a lot to cover, so let’s get on with it!
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